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Note to Reader

The Manual
Advanced Word Processing for Microsoft Office 2007 for ECDL offers a practical, step-by-step guide 
for those who wish to upgrade their Word Processing skills to acquire a thorough competence in 
this application.  Similar to the other Blackrock Education Centre training materials, it has been  
designed as either a stand-alone study guide or for use in a tutor-led environment. However, as is 
characteristic of Blackrock Education Centre training materials, the content of this manual offers  
additional support information through explanations, demonstrations and practical exercises as 
well as a support website, www.becpublishing.com. 

Design
Every use has been made of the expertise we have gained  training students in ICT over  many years.  
The knowledge and skills of our substantial pool of trainers hugely influenced the content and lay-
out of the material.

The manual is written in plain English.•	

There are step-by-step, detailed explanations and action sequences. •	

Particular attention is given to  relating what is  seen on the pages of the manual to what is seen •	
on the computer screen.  

The A4 size of the manual and the side-by-side layout of graphics and text, combine to make it •	
an ideal training manual.

Exercises
At the end of each section, there are two kinds of exercises.  There are self-check questions designed 
to jog your memory of important details.  There are also practical exercises that have been designed 
to revise some of the more important skills associated with using Microsoft Word. 

In successfully completing each set of exercises, the student can be confident, that  progress in 
learning more sophisticated skills has been achieved.

Web Support
Support material is available at www.becpublishing.com.  

This manual was produced – text, design and layout – using only the Microsoft Office suite  
of programs and the skills described in the manual. The screen shots were captured using  

a small utility program and most were inserted directly onto the page.
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Practice Sequence  

1 Open the document named Sports and Locations in Spain.  

2 Notice the graphic that has been inserted on page 1. Try dragging it to a new location on 
the page. It is confined to normal text movements as its wrapping style is In line with 
text. 

 

3 Click the picture once to select it. Using the Picture Tools/Format tab and the Arrange 
group of options, select the Square wrapping style and then Right horizontal alignment.  
If you wish, you can drag the image with the mouse to adjust its position slightly on the 
right side of the page. 

 

4 Change the layout for your graphic so that it is using the Behind text wrapping style on 
the Left for the horizontal alignment. View the changes on the page. 

 

5 Change the layout for the image so that it uses the Square wrapping style in the Centre 
for the horizontal alignment. 

 

6 Change the layout for the image so that it is still in the centre but this time the wrapping 
style is Tight. 

 

7 Move the graphic to another location on the page and observe what happens to the 
wrapping style when the graphic is repositioned. 

 

8 Go to page 2 and select the graphic under the heading About Spain and its Locations. 
Click to select the graphic. Using the Picture Tools/Format tab and the Arrange group 
of options, set the layout so that the graphic is using the Square wrapping style in the 
Centre horizontal position. Notice the position of the graphic on the page and within the 
paragraph with which it is associated. 

 

9 Save the document but do not close it.  

 
 

Practice Sequence  

1 Ensure the document named Sports and Locations in Spain is open  

2 Access the Advanced Layout window for the selected graphic on page 2. Click the Text 
Wrapping tab. In the Distance from text section, set the Left setting to 1cm and the 
same for the Right setting. Click the Picture Position tab and in the Vertical section, set 
the Absolute position to 7.5cm below the Paragraph. Click OK twice to return to the 
document. 

 

3 Return to page 1 of the document and select the graphic on this page. From the Picture 
Tools/Format tab and the Arrange group click the Text Wrapping button. Select the 
Edit Wrap Points option. Wrap points will appear around the boat image. Using the 
mouse, drag the wrap points in and out to alter how the text wraps around the image. 
When you have finished, click the Text Wrapping button. Select Edit Wrap Points to 
turn the option off. 

 

4 Save the document and close it.  
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Practice Sequence 

1 Open the document called Text_wrap_table.  

2 Apply text wrap to the table so that it wraps to the right of the text. Ensure that the 
positioning is set so that the distance from the surrounding text is 0.5cm from the left and 
right. If you need help: 
 
Select the table and then click the Table Tools/Layout tab. Select the Properties button 
in the Table group. Select the Table tab and the select the Around text wrapping option. 
Select the Positioning button and then change the Left and Right measurements for the 
distance from surrounding text to 0.5 cm. Click OK twice to return to the document. 

 

3 
Save the document and close it.  

4 
Open the document called text_wrap_chart.  

5 Apply text wrap to the chart so that it wraps tightly to the left of the text. Ensure that the 
positioning is set so that the distance from the surrounding text 1cm from the top and 
bottom. If you need help: 
 
Select the chart and then click the Chart Tools/Format tab. Select the Text Wrapping 
button in the Arrange group. Select More Layout Options. Select the Text Wrapping 
tab. Select the Square wrapping style and the Left Only wrap text option. In the 
Distance from text section, set the Left setting to 1 cm and the same for the Right 
setting. Click the Picture Position tab and in the Vertical section, set the Absolute 
position to 1.5cm below the Paragraph. Click OK to return to the document. 

 

6 
Save the document and close it.  

7 Open the document called text_wrap_drawn_object. 
 

 

8 Select the star shape and then right mouse click and choose Format AutoShape. Click 
the Layout tab. Select the Tight wrapping style and then Left horizontal alignment. Click 
OK to return to the document. If you wish, you can drag the shape with the mouse to 
slightly adjust its position on the left side of the page 

 

9 Access the Advanced Layout window for the selected shape. Click the Text Wrapping 
tab. In the Distance from text section, set the Left setting to 0.5cm and the same for the 
Right setting. Click the Picture Position tab and in the Vertical section, set the 
Absolute position to 3cm below the Paragraph. Click OK to return to the document. 

 

10 
Save the document and close it.  

 
 
1.2 Find and Replace Options for Formatting (3.1.1.2) 
This section draws on existing knowledge in using the Find and Replace feature to find text in a 
document and replace it with alternative text. It also advances knowledge of this feature further by 
searching for items based on font and paragraph formats, paragraph marks and page breaks.  
 
1.2.1 Font Formats 
Font formats refer to font types, font styles (including underline styles), font colours, font effects and 
font sizes.  
 
To find and replace text based on font formats do the following: 
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Find 
 Select the Editing group from the Home tab. 
 Select Find. 
 The Find and Replace window opens. 
 Ensure that the Find tab is selected.  

 

 

 
 
 
 
 
 
 
 
 
 To find specific text, enter the text into the Find What box otherwise leave this blank. 
 Click More>> to see further options in the Find and Replace window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Select the Format button.  

A pop-up menu appears. 
 
 
 
 
 
 
 
 
 Select the Font menu option. 

The Font window opens. 

Select Font

Click More>> to extend 
the Find and Replace 
window and give more 

options. The button 
changes to a <<Less 

button. When the 
required options have 

been selected, click 
<<Less to reduce the 

size of the window 

Select the Format 
button 
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Note how a new Format: section has appeared below the Find what: box listing the 
chosen formatting. 
 
 
 
 

 

 In the Font tab, select the required font,  
font, style, font size, font colour,  
underline style and font effects. 

 Click OK. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 Select the Find Next button to find the first instance of text with this  

formatting in the current document.  
 Select Find Next until all instances have been found.  

A message will appear stating that Word has  
finished searching the document. 

 Click OK. 
 Click Close. 

 
 
Replace 
 From the Home tab and the Editing group, select the Replace button  

The Find and Replace window opens. 
 Click More>> (if already selected, the <<Less button will be displayed).  
 If an existing format is displayed, select the No Formatting button at the bottom of the window. 

 
 
 
 
 
 Click the mouse in the Find What box. 
 Select the Format button. 
 Click Font. 
 Choose the font, size, colour, style, etc. that you want to replace.  

Select a font, font 
style, font size, font 

colour, underline 
style and/or font 
effects from this 

window 

note 

The chosen formatting is 
displayed 

Select the No Formatting 
button to remove existing 
formatting 
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To replace all instances of the chosen format throughout the document, select 
Replace All. A message will appear when Word has finished performing the 
replacement procedure throughout the entire document, showing how many changes 
were made. Click OK. 

 
 
 

 

 Click OK. 
 Click in the Replace With box and then select the Format button. 
 Select Font.  
 From the Font window choose the font, size, style, colour, etc. that you want to replace the 

existing format. 
 Click OK. 
 To replace the chosen format with the new format, step by step, select the Replace button 

between each replacement.  
A message will open when Word has finished searching the entire document.  

 Click OK. 
 Select the Close button to exit the Find and Replace window. 

 
 

 
 
 
 
 
 

 
 

 
1.2.2 Paragraph Formats 
Paragraph formats refer to alignment, indentation, and paragraph and line spacing.  
 
To find and replace text based on paragraph formats do the following: 
 
Find 
 Select the Home tab and then, from the Editing group, select the Find button. 

The Find and Replace window opens. 
 Ensure that the Find tab is selected. 

 

 

 
 
 
 
 
 
 
 
 To find specific text, enter the text into the Find What: box otherwise leave blank. 

 
For more advanced text wrapping and positioning options, do the following: 
 Click the More>> button to see further options in the Find and Replace  

window.  
If an existing format is displayed, select the No Formatting button. 

 Select the Format button.  
A pop-up menu appears. 

 
 
 

Select the Format button 

Select
Paragraph

note 
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Note how a new Format: section has appeared below the Find what: box listing the 
chosen formatting. 
 
 
 
 
 
 
 
 
 

 Select the Paragraph menu option. 
The Paragraph window opens.  

 Ensure that the Indents and Spacing tab is selected. 
 Select a paragraph format, such as Alignment, Indentation, Paragraph Spacing and/or Line 

Spacing. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Click OK. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 Select the Find Next button to find the first instance of text with this  

formatting in the current document.  
 Select Find Next until all instances have been found.  

A message will open stating that Word has finished searching the document. 
 Click OK. 

 
 
 
 

Select an alignment 

Select an indentation 

Select paragraph 
spacing 

Select line spacing 

note 

The chosen formatting is 
displayed 



2

Referencing  Chapter 2  Training for ECDL 

86    Unauthorised Photocopying is Unlawful 

 
 
 
Cross-references can be used to point the reader to another subject within the document. You can refer 
to such elements as headings, footnotes and endnotes, bookmarks, captions, numbered items, tables 
and figures.  
 
 
6.1 Creating Cross-References (3.2.3.2) 
Cross-references can only be created within the current document. If you need to make references 
across multiple documents, you need to combine all of the documents into a master document.  
 
To create a cross-reference to an index entry, see Section 4 Working with Indexes and 4.2.3 Create 
a Cross-reference to an Index Entry. 
 
To create a cross-reference, do the following: 
 Click where the cross-referenced information is to appear. 
 From the References tab and the Captions group select Cross-Reference.  

The Cross-reference window opens. 
 From the Reference type: box make an  

appropriate selection. See Section 6.1.1  
for a list of options. 

 Make a choice from the Insert reference to:  
box. See Section 6.1.2. 

 Select which item you wish to reference from  
the For which heading: box. 

 Tick Insert as hyperlink if you are saving your  
document as a web page and want to make the  
references into hyperlinks so that visitors to the  
page can simply click the hyperlink to access  
its reference. 

 Check the Include above/below box if  
appropriate. See Section 6.1.3. 

 Click Insert to create the cross-reference. 
 
 
6.1.1 Reference Types 
 

Numbered Item Lists all the text entries beginning with a number throughout the document. 

Heading Shows all headings based on the styles Heading 1, Heading 2, etc. or outline levels.  

Bookmark Displays all the bookmarks currently available within the document. 

Footnote Shows all footnotes inserted in the document. 

Endnote Lists all endnotes that have been created. 

Equation Shows any equations that have been inserted into the document. 

Figure Lists all figure references. 

Table Shows all available tables within the document. 

Section 6  Cross-References  
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If you find it difficult to highlight some of your cross-references, you may find it easier to display 
the entire code and then make the deletion. To turn on the display of field codes within a 
document, press ALT+F9. 

You can request that all field codes (include cross-references) are automatically updated when 
you print. This can be a great safety guard if you forget to update an entire document before 
printing. Choose Print from the File menu. From the Print window click the Options button. Tick 
the Update Fields box and click OK. 

6.1.2 Insert Reference to Options 
The Reference type: box will change depending on which reference type you have selected. 
Typically, this box enables you to choose what type of reference you want. For example, you may 
want to display a reference’s page number, or paragraph number, or the heading reference itself. 
 
There are two special types of reference that can be inserted that may be confusing: Paragraph (no 
context) and Paragraph (full context). Imagine that you want to reference a paragraph that is 
numbered 1. a) ii. If you selected to insert the reference using Paragraph (no context) the reference 
for that paragraph would be ii. If you used Paragraph (full context), the reference for that paragraph 
would be 1. a) ii. 
 
6.1.3 Include Above/Below 
The Include Above/Below option is used to create a relative reference to a particular item. This 
helps readers locate the reference more quickly by letting them know in which direction (up or down 
the page) the reference text can be found 
 
Imagine that you are referencing the page number of a particular heading. By ticking the Include 
Above/Below option, if the referenced text appears on the same page as the reference, Word will 
automatically insert the word Above or Below based on the position of the reference. 
 
 
6.2  Deleting Cross-References (3.2.3.2) 
Cross-references are actually special field codes that are embedded into your document. When you  
move the cursor over a cross-reference location, the reference usually displays with a grey background.  
 
To delete a cross-reference, do the following: 
 Highlight the cross-reference that appears in the document (remember that cross-references 

display with a grey background). 
 Press Delete. 

   
 
 
 
 
 
6.3 Updating Cross-References 
If you wish to move a cross-reference, you can simply select it and cut and paste it into a new 
location. As your document changes, you may also find that your cross-references need updating. For 
example, the number of pages in your document may change and any cross-references displaying 
page numbers will need to be updated.  
 
To update cross-references, do the following: 
 
Single Cross-Reference 
 Highlight the cross-reference. 
 Press F9 to update the field.  

 
All Cross-References 
 Select the entire document (use the mouse or CTRL+A to highlight the whole document). 
 Press F9. 

   
 

note

note
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If you find it difficult to highlight some of your cross-references, you may find it easier to display 
the entire code and then make the deletion. To turn on the display of field codes within a 
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6.3 Updating Cross-References 
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note

note
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A data source file may be in database format, if created through the Mail Merge process, or 
in word processed table format, if the data has been entered directly into a table and then 
saved as a Word document. The process of editing a data source is slightly different 
depending on the format of the data source. 

 

 
 
 
 
Mail merge is used to join or merge two sources of information into a single document. Its most 
common uses are for producing form letters and mailing labels. 
 
A form letter is a letter with standard information that is sent to many people but where each letter 
must have some individual information, such as the person’s name, company, address, etc. 
 
The source of this individual information is known as the data file or data source. A data file 
contains individual details for each person that you want to send a letter to. These individual details 
are known as records. The records in a data file are merged with a form letter to produce personalised 
letters.  
 
 
 
 
 
 
 
 
 
3.1 Using the Mail Merge Task Pane (3.3.3.1) 
One of the easiest ways to work with the mail merge process is by using the Mail Merge Task Pane. 
The task pane steps you through the necessary tasks needed to create or edit form letters, data files 
and mailing labels.  
 
To start the Mail Merge Task Pane, do the following: 
 Select the Mailings tab. 
 Select the Start Mail Merge arrow.  
 Choose Step by Step Mail Merge Wizard… from the menu.  

The Mail Merge task pane opens. 
 Use the available options to perform the various mail merge steps,  

clicking Next to continue to the next step in the Mail Merge process. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
3.1.1 Creating a New Data Source 
There are two methods available to create a new data source; as a data file saved as a database, created 
through the Mail Merge Wizard, or as a Word table. Both methods are shown below. 

Section 3  Mail Merge
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Using Mail Merge Wizard 
 In Word, create a new document or open an existing document and select the Mailings tab. 
 Select the Start Mail Merge arrow.  
 Choose Step by Step Mail Merge Wizard… from the menu.  

The Mail Merge task pane appears. 
 Ensure that the Letters option button is selected and click Next: Starting Document. 
 Click the option button relevant to your document: if using the existing document select the Use 

the Current Document option button; if you are starting the mail merge procedure from an 
existing mail merge document, select Start from Existing Document and choose the document 
from the list and click Open. 

 Click Next: Select Recipients. 
 Select the Type a New List option button. 
 Select Create…  
 The New Address List window opens displaying default  

column headings (called field names): 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Select the Customize Columns button to add or  

delete the existing columns in the address list. 
The Customize Address List window  
opens. 

 
 
 
 
 
To delete a field name, do the following: 
 Select the field name. 
 Click Delete.  
 Click Yes to confirm the deletion. 

The address list 
displays default 

column headings 

To amend the column headings, 
click Customize Columns 

To create a new entry in 
the address list, click New 

Entry and to delete 
entries click Delete Entry 

To find records in the address list click Find 
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The Mail Merge task pane appears. 
 Ensure that the Letters option button is selected and click Next: Starting Document. 
 Click the option button relevant to your document: if using the existing document select the Use 

the Current Document option button; if you are starting the mail merge procedure from an 
existing mail merge document, select Start from Existing Document and choose the document 
from the list and click Open. 

 Click Next: Select Recipients. 
 Select the Type a New List option button. 
 Select Create…  
 The New Address List window opens displaying default  

column headings (called field names): 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Select the Customize Columns button to add or  

delete the existing columns in the address list. 
The Customize Address List window  
opens. 

 
 
 
 
 
To delete a field name, do the following: 
 Select the field name. 
 Click Delete.  
 Click Yes to confirm the deletion. 

The address list 
displays default 

column headings 

To amend the column headings, 
click Customize Columns 

To create a new entry in 
the address list, click New 

Entry and to delete 
entries click Delete Entry 

To find records in the address list click Find 
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To add a field name, do the following: 
 Select the Add button.  

 The Add Field window opens. 
 Enter the field name. 
 Click OK.  

 
To move the new field name into position, do the following:  
 Select the field name. 
 Select the Move Up or Move Down buttons. 

 
To rename an existing field, do the following: 
 Select the field name. 
 Select the Rename button.  
 Enter the new name into the To box. 
 Click OK. 

 
To enter the records into the new address list, do the following: 
 Press the Tab key between each field.  
 Select the New Entry button to begin entering a new record. 
 When the address list is complete, select OK. 
 Save the address list with a relevant name (it will save in database format in the My Data Sources 

folder unless you specify a different location). 
 Click Save. 
 The Mail Merge Recipients list opens.  
 Click OK. 

 
Using a Word Table 
 Create a new document and, from the Insert tab and the Tables group, select the Table arrow. 
 Select Insert Table. 
 Enter the number of columns and rows required for the address list. 
 Click OK. 
 Enter the field names in the first row of the table. 
 Enter the records into the table, using the Tab key to move the cursor between fields (use Shift + 

Tab to return the cursor to the previous field). Ensure that the fields are entered under the correct 
field names. 

 From the Microsoft Office Button, select Save As. 
The Save As window opens. 

 Select the correct drive and/or folder from the Save In drop-down box where the file is to be saved. 
 Enter a filename for the data source. 
 Click Save. 

 
3.1.2 Using an Existing Data Source 
If a data source already exists, it can be attached to a form letter to create a mail merge document. A 
data source can be saved as a Word table or a database data file. Whichever format the data source is 
saved in, both can be opened through the Mail Merge Wizard. 
 
To use an existing data source, do the following: 
 Open the data source and select the Mailings tab. 
 Select the Start Mail Merge arrow.  

Enter the field name 
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 Choose Step by Step Mail Merge Wizard… from the menu.  
The Mail Merge task pane opens. 

 Ensure that the Letters option button is selected and click Next: Starting Document. 
 Click the option button relevant to your document. 

If using the existing document select the Use the Current  
Document option button; if you are starting the mail merge  
procedure from an existing mail merge document, select Start  
from Existing Document and choose the document from the list. 

 Click Open. 
 Click Next: Select Recipients. 
 Select the Use an Existing List option button. 
 Click the Browse button. 
 Select the data source file. 
 Click Open. 
 The Mail Merge Recipients window opens. 
 Click OK to exit the window and return to your document. 

 
 To continue the mail merge procedure, select Step 4 of 6 Write your Letter. 
 
3.1.3 Inserting Merge Fields 
Merge fields are the fields that are selected and used when creating a new address list.  
 
To add the address list fields to the document, do the following: 
 Ensure that the cursor is in the correct position within the document. 
 At Step 4 of 6 Write your Letter, select More Items. 

The Insert Merge Field window opens. 
 
 
 
 
 
 
 
 
 

 Select the Database Fields option button. 
 Select a field from the list and click Insert 
 Select Close. 

 
 
 
 
 
 
 
 
 
 
 
 
 Press the spacebar or the Enter key to create a space and reselect More Items. 
 Repeat the above procedure until all the merge fields are inserted into the correct positions within 

the document. 

Select a field 

Click Insert 
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To add a field name, do the following: 
 Select the Add button.  

 The Add Field window opens. 
 Enter the field name. 
 Click OK.  

 
To move the new field name into position, do the following:  
 Select the field name. 
 Select the Move Up or Move Down buttons. 

 
To rename an existing field, do the following: 
 Select the field name. 
 Select the Rename button.  
 Enter the new name into the To box. 
 Click OK. 

 
To enter the records into the new address list, do the following: 
 Press the Tab key between each field.  
 Select the New Entry button to begin entering a new record. 
 When the address list is complete, select OK. 
 Save the address list with a relevant name (it will save in database format in the My Data Sources 

folder unless you specify a different location). 
 Click Save. 
 The Mail Merge Recipients list opens.  
 Click OK. 

 
Using a Word Table 
 Create a new document and, from the Insert tab and the Tables group, select the Table arrow. 
 Select Insert Table. 
 Enter the number of columns and rows required for the address list. 
 Click OK. 
 Enter the field names in the first row of the table. 
 Enter the records into the table, using the Tab key to move the cursor between fields (use Shift + 

Tab to return the cursor to the previous field). Ensure that the fields are entered under the correct 
field names. 

 From the Microsoft Office Button, select Save As. 
The Save As window opens. 

 Select the correct drive and/or folder from the Save In drop-down box where the file is to be saved. 
 Enter a filename for the data source. 
 Click Save. 

 
3.1.2 Using an Existing Data Source 
If a data source already exists, it can be attached to a form letter to create a mail merge document. A 
data source can be saved as a Word table or a database data file. Whichever format the data source is 
saved in, both can be opened through the Mail Merge Wizard. 
 
To use an existing data source, do the following: 
 Open the data source and select the Mailings tab. 
 Select the Start Mail Merge arrow.  

Enter the field name 
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 Choose Step by Step Mail Merge Wizard… from the menu.  
The Mail Merge task pane opens. 

 Ensure that the Letters option button is selected and click Next: Starting Document. 
 Click the option button relevant to your document. 

If using the existing document select the Use the Current  
Document option button; if you are starting the mail merge  
procedure from an existing mail merge document, select Start  
from Existing Document and choose the document from the list. 

 Click Open. 
 Click Next: Select Recipients. 
 Select the Use an Existing List option button. 
 Click the Browse button. 
 Select the data source file. 
 Click Open. 
 The Mail Merge Recipients window opens. 
 Click OK to exit the window and return to your document. 

 
 To continue the mail merge procedure, select Step 4 of 6 Write your Letter. 
 
3.1.3 Inserting Merge Fields 
Merge fields are the fields that are selected and used when creating a new address list.  
 
To add the address list fields to the document, do the following: 
 Ensure that the cursor is in the correct position within the document. 
 At Step 4 of 6 Write your Letter, select More Items. 

The Insert Merge Field window opens. 
 
 
 
 
 
 
 
 
 

 Select the Database Fields option button. 
 Select a field from the list and click Insert 
 Select Close. 

 
 
 
 
 
 
 
 
 
 
 
 
 Press the spacebar or the Enter key to create a space and reselect More Items. 
 Repeat the above procedure until all the merge fields are inserted into the correct positions within 

the document. 

Select a field 

Click Insert 
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 Repeat the above procedure until all the merge fields are inserted into the correct positions within 
the document. 
Merge fields appear as field headings as shown on the right. 

 
 
 
 
 
 
 To see the merge fields as records instead of as field headings,  

select the Preview Results button. 
 Use the navigation arrows to view the next record(s) or previous  

record(s). 
 
3.1.4 Merging Data 
The data source and the document are now ready to be merged into one document.  
 
To complete the mail merge procedure, do the following: 
 Select Next: Preview Your Letters. 

This task pane enables the user to either preview the letters or make changes. 
 Use the arrows to view each recipient within the document to check that they have been entered 

correctly. 
 Select Exclude this Recipient to exclude the currently displayed recipient from the mail merge 

procedure. 
 Select Edit Recipient List to make changes to the address list. 
 In the Data Source section of the window, select the data source. 
 Click Edit. 
 The Edit Data Source window opens. 

 Edit the records by clicking into the relevant field(s) and making changes. 
 Create a new record by selecting the New Entry button. 
 Delete an entry by selecting the record and then clicking Delete Entry. 

 Confirm the amendments/update and/or deletions by selecting the Yes button. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Click OK twice to return to the task pane. 
 Select Next: Complete the Merge. 

Merge Fields 
examples  

At the next step, there are two choices: print the merged letters without merging the data source 
and the letter or complete the merge. 
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To print the mail merge document without merging the data source permanently with the letter, do the 
following: 
 Select Print. 
 Select All.  
 Click OK. 

 
To complete the merge procedure and merge the data source with the 
letter as a new merged document,  
 Select Edit Individual Letters.  
 Select All. 
 Click OK.  
 Resave the merged document.  

 
 
 
3.1.5 Using the Mailings Tab 
The mail merge procedure can also be performed using the buttons on the Mailings tab. 
 

 
 
 
 
 
 
 
 

Practice Sequence  

This exercise is designed as a refresher for the basic mail merge procedure. In the first part of this exercise, 
you will create a simple form letter. 

1 Start a new blank document and type the following letter. 
 

Ref: TR1/73 
 
Dear  
 
Please find enclosed our latest corporate travel brochure, including the latest 
revisions for flight schedules for all major airlines. 
 
As you know, etc., etc. … 

 

2 Save the document as Corporate Travel Letter. Do not close the letter.  

In this part of the exercise, you will use the Mail Merge Task Pane to create the form letter from the contents of 
the current document. 

3 From the Mailings tab and the Start Mail Merge group, select Step by Step Mail Merge 
Wizard. 

 

4 Click the Letters option button under the Select Document Type heading and click Next.  

5 Select Use the Current Document to show Word that the current document contains the 
content for your form letter. Click Next. 

 

Step 1:  
Select Start 
Mail Merge 

and click 
Letters 

Step 2:  
Select Select 
Recipients and 
click Use 
Existing List or 
Type New List 

Step 3:  
Click Edit 
Recipient List 
to make 
changes to the 
address list 

Step 4:  
Insert 
Merge 
Fields 

Step 5: 
Preview 
results 

Step 6: 
Select 
Finish & 
Merge  
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6 On a blank line, type (c) and then press the space bar. AutoCorrect should insert the © 
symbol for you. 

 

7 

On a blank line, type the following text. When Word capitalises the word travel, use undo to 
revert back to a lowercase letter. 
 
All personnel, e.g. travel consultants, tour co-ordinators, etc., will need to arrive 
before 8am. 

 

8 
Access the AutoCorrect window. In the Replace box type hhi and in the With box type 
Happy Holidays International. Click the Add button and then click OK. Test your new 
replacement by typing hhi and then pressing the space bar.  

 

9 Access the AutoCorrect window and delete the rule that you have just created. Return to 
the document on completion. 

 

10 Close the document without saving the changes.  

 
 
5.2 Automatic Text Formatting (3.3.5.1) 
Consistent formatting in documents not only saves time but also provides a specific look and feel to 
your work. Word makes it easy to format documents in a standard way, using the AutoFormat as you 
Type feature. You can either let AutoFormat work with you as you type or leave it until the document 
is complete and then have AutoFormat do the checking and correcting for you. 
 
5.2.1 AutoFormat As You Type 
Word will automatically format your text as you type as the AutoFormat is active by default. You 
may, however, wish to change some of the AutoFormat As You Type options to ensure that what 
Word is doing suits your own formatting requirements. 
 
To change the AutoFormat options, do the following: 
 From the Microsoft Office Button select  Word Options.  
 From the Proofing tab, select the AutoCorrect Options button.  

The AutoCorrect window opens.  
 Click the AutoFormat As You Type tab. 
 Make any necessary changes. 
 Click OK to return to your document.  

See sections 5.2.2, 5.2.3 and 5.2.4 for  
more details on the AutoFormat As  
You Type options. 
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5.2.2 Apply As You Type Options 
 
Built-In Heading Styles 
If this option is checked, built-in headings styles are automatically applied to your text, depending on 
certain circumstances: the heading must be fewer than six words and must not end with any 
punctuation. You must also have pressed Enter twice before the heading text (i.e. at the end of the 
previous paragraph). 
 
For Heading 1, type a new line of heading text. For Heading 2, precede the new line of text with a 
single tab. For Heading 3, precede the new line with two tabs. Each time you include an extra tab 
space before the heading text, the heading style is taken to the next level, such as Heading 4, Heading 
5, down to Heading 9. 
 
 

For example 
  Having pressed the Enter key twice, type a line of text that has few than five words 
  Do not include a full stop 
  Press the Enter key twice 
 
 The text is formatted using the Heading 1 style 
 
 
  Having pressed the Enter key twice, press the Tab key 
 Type a line of text that has few than five words  
  Do not include a full stop 
  Press the Enter key twice 
    
 The text is formatted using the Heading 2 style 
 

 
Border Lines 
If you check the Border Lines option in the Apply As You Type section, borders can be added above 
or below a paragraph by typing three or more of the special characters listed below. 
 
If you:  Type three or more hyphens (-) or underscores (_) and then press Enter, a single line 

border will be inserted by the AutoFormat feature. 
 
 
 
If you: Type three or more equal signs (=) and then press Enter, a double line border will be 

inserted by the AutoFormat feature. 
  
  
 
If you: Type three or more asterisks (*) and then press Enter, a dotted line border will be 

inserted by the AutoFormat feature. 
 
 
 
If you: Type three or more tildes (~) and then press Enter, the AutoFormat feature will insert 

a wavy line border. 
 
 
 
If you: Type three or more hashes (#) and then press Enter, the AutoFormat feature will 

insert a decorative line border. 
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Tables 
If you check the Tables option in the Apply As You Type section, you can create tables by using the 
plus sign (+) to indicate a column border and hyphens (-) or underscores (_) to indicate the column 
width. Then press Enter to create the table. 
 

+_____+______________________+_________________+_______________+ 
 

    
 
 

Automatic Bulleted Lists 
If you check the Automatic bulleted lists option in the Apply As You Type section, Word will 
automatically format a list for you with the bullet symbol you use for the first line of the list. Each 
time you press the Enter key, Word provides you with another bullet symbol for the next item. When 
you press Enter twice, Word considers that you have finished the list and the bullet is deleted from 
that line. 
 
Automatic Numbered Lists 
If you check the Automatic numbered lists option in the Apply As You Type section, Word will 
automatically format a list for you with a numbering system based on the number or letter you use for 
the first line of the list. Each time you press the Enter key, Word provides you with another 
number/letter in the sequence for the next item. When you press Enter twice, Word considers that 
you have finished the list and deletes the number from that line. 
 
 

Practice Sequence  

1 Ensure you are working in a new blank document.  

2 Access the AutoCorrect window by selecting Word Options from the Microsoft Office 
Button. From the Proofing tab, click the AutoCorrect Options button. Click the 
AutoFormat As You Type tab and set the Apply As You Type options as shown below. 
 

 
 
 
 
 

 

3 Click OK to accept the changes and then click OK to return to the document.  

4 Type three tildes (~~~) on a blank line and then press Enter. A wavy line should appear. 
Now type three asterisks (***) on a blank line and press Enter. A dotted line should appear. 

 

5 On a blank line, type the following example and then press Enter. 
 
+-------------------------------+------------+--------+---------+ 

 

6 On a blank line type the sequence a) then press the Tab key. Type Cats and then press 
Enter. On the next line type Dogs and press Enter. On the last line type Ponies and this 
time press Enter twice to end the numbered list. 

 

7 Close the document without saving it.  

 
5.2.3 Replace As You Type Options 
The Replace as you type options can be used to control the automatic replacement of specific text. 
This is activated by pressing the space bar after the text has been typed. 
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Straight Quotes with Smart Quotes 
If checked, standard quotation marks ("text") are replaced with smart quotes (“text”). 
 
Ordinals (1st) with Superscript 
If checked, ordinals (st, nd, rd, th, etc) are enhanced with superscript formatting. For example: 1st, 
2nd, 3rd, 4th, etc become 1st, 2nd, 3rd, 4th, etc. 
 
Fractions (1/2) with Fraction Character (½) 
If checked, fractions separated by the slash symbol (/) are automatically formatted as fraction 
characters. For example: 1/2 becomes ½, 1/4 becomes ¼, etc. 
 
Symbol Characters (--) with Symbols (hyphens/dash) 
If checked, you can type a special shortcut of characters and when you press the SPACEBAR, 
AutoFormat automatically inserts the symbol the shortcut represents. For example: (r) changes to ®, 
(TM) changes to ™, (c) changes to © and -- changes to — 
 
*Bold* and _Italic_ With Real Formatting 
If checked, when you type a word or phrase that starts and finishes with an asterisk (*) the text 
between the two asterisks will be changed to bold. If you use the underscore character (_) then the text 
between the two underscores changes to italics. 
 
Internet and Network Paths with Hyperlinks 
If this option is checked, if you enter a web address, such as www.blackrock.edu.ie, then 
AutoFormat will automatically convert the address into a hyperlink, such as www.blackrock.edu.ie. 
This means that if someone clicks on the link, their internet browser is opened and the address is 
searched for on the web. 
 

Practice Sequence  

1 Ensure you are working in a new blank document.  

2 Access the AutoFormat as You Type tab in the AutoFormat window.  

3 Set the Apply as You Type options as shown below. 
 
 
 
 
 
 

 

4 Ensure that the Replace as You Type options are also set as shown below. 
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Practice Sequence  

1 Open the document entitled Edited Draft Travel Information.   

2 Imagine that this document has been sent to you by a colleague within your 
organisation for your review. You will review the suggested changes and decide 
whether to accept or reject them. 

 

3 Ensure you are working at the top of the document. Click the Track Changes button. 
Click the Next button to locate the first change. From the Accept drop-down menu, click 
the Accept and Move to Next option to confirm the deletion of the word ensure and 
then Accept and Move to Next again to confirm the insertion of the word guarantee. 
Now review the remainder of the changes making your own decision as to what is 
accepted or rejected. 

 

4 Save the document and close it.   

 
 
1.7 Comparing and Merging Documents (3.4.1.4) 
Revisions made by more than one author on the same document can be compared and combined 
(merged) into one document. 
 
To compare/merge documents, do the following: 
 In the Compare group of the Review tab, select the Compare 

arrow. 
 Click Compare to compare two versions of a document or 

Combine to combine revisions from multiple authors into a single 
document. 
The Compare or Combine window opens, depending on the 
chosen option. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Select the Original document from the drop-down list.  
 Click the Browse folder to locate the file if necessary. 
 Enter a label with which to display unmarked changes (or retain the default label that is displayed). 
 Locate the Revised document and enter a label with which to display marked changes (or retain 

the default label that is displayed). 
 Select or deselect the Comparison settings check boxes as required. 
 Select the Word Level option button in the Show changes at: section.  
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 Choose an option from the Show changes in: section (if you click New Document the changes 
will be combined in a new document). 

 Click OK to return to the document. 
 

The example below shows changes combined in a new document. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 For more display options, click the Show Source Documents arrow and choose an option from 

the menu. 
 
 
 

 
 
 

 
 

 
 Accept or reject changes as required and save the document. 

 
Practice Sequence  

1 Open the document entitled Edited Draft Travel Information.  

2 
Compare the original document Draft Travel Information with the edited version. Ensure 
that all of the Comparison settings are selected. Select Word Level and New 
Document. 

 

3 Merge/combine the two documents into one document.  

4 Save the merged document as Combined Draft Travel Information and close all open 
documents.  

 

  

The original and 
revised documents 
are displayed here 

The combined 
document is 
displayed here 

The changes 
are displayed 

here 

Choose an 
option from 

the list 
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Practice Sequence  

1 Open the document entitled Edited Draft Travel Information.   

2 Imagine that this document has been sent to you by a colleague within your 
organisation for your review. You will review the suggested changes and decide 
whether to accept or reject them. 

 

3 Ensure you are working at the top of the document. Click the Track Changes button. 
Click the Next button to locate the first change. From the Accept drop-down menu, click 
the Accept and Move to Next option to confirm the deletion of the word ensure and 
then Accept and Move to Next again to confirm the insertion of the word guarantee. 
Now review the remainder of the changes making your own decision as to what is 
accepted or rejected. 

 

4 Save the document and close it.   

 
 
1.7 Comparing and Merging Documents (3.4.1.4) 
Revisions made by more than one author on the same document can be compared and combined 
(merged) into one document. 
 
To compare/merge documents, do the following: 
 In the Compare group of the Review tab, select the Compare 

arrow. 
 Click Compare to compare two versions of a document or 

Combine to combine revisions from multiple authors into a single 
document. 
The Compare or Combine window opens, depending on the 
chosen option. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Select the Original document from the drop-down list.  
 Click the Browse folder to locate the file if necessary. 
 Enter a label with which to display unmarked changes (or retain the default label that is displayed). 
 Locate the Revised document and enter a label with which to display marked changes (or retain 

the default label that is displayed). 
 Select or deselect the Comparison settings check boxes as required. 
 Select the Word Level option button in the Show changes at: section.  
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 Choose an option from the Show changes in: section (if you click New Document the changes 
will be combined in a new document). 

 Click OK to return to the document. 
 

The example below shows changes combined in a new document. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 For more display options, click the Show Source Documents arrow and choose an option from 

the menu. 
 
 
 

 
 
 

 
 

 
 Accept or reject changes as required and save the document. 

 
Practice Sequence  

1 Open the document entitled Edited Draft Travel Information.  

2 
Compare the original document Draft Travel Information with the edited version. Ensure 
that all of the Comparison settings are selected. Select Word Level and New 
Document. 

 

3 Merge/combine the two documents into one document.  

4 Save the merged document as Combined Draft Travel Information and close all open 
documents.  

 

  

The original and 
revised documents 
are displayed here 

The combined 
document is 
displayed here 

The changes 
are displayed 

here 

Choose an 
option from 

the list 
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In this example you will copy the formatting characteristics from section 3 into section 2. 

9 Select Draft View so that you can easily view your section breaks.  

10 Highlight the section break at the end of section 3 by clicking to the left of the section 
break indicator. Click the Copy button on the Clipboard group/Home tab. 

 

11 Scroll up through the document until you can see the section break at the end of section 
2. Highlight this section break and then click the Paste button. 

 

12 Using Print Preview, view the entire document and notice the changes that have been 
made. 

 

13 Save the document on completion.  

 
 
1.6 Changing the Type of Section Break (3.5.1.1) 
When you have inserted a section break, you can change its type at any time. Changing a section 
break type is often more preferable than deleting an existing break and inserting a new one, as the 
deletion process often changes the page formatting of the two sections that become joined.  
 
To change a section break to a different type, do the following: 
 Ensure that you have clicked anywhere below the section break that you wish to change. 
 Select the Page Setup window launcher icon in the Page Layout tab. 

The Page Setup window opens. 
 Click on the Layout tab.  
 Make a selection from the Section start box. 
 Ensure Apply to box is set to This section. 
 Click OK to continue. 
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2.1 Headers and Footers (3.5.2.1) 
Headers and footers apply to the top and bottom sections of a page in a document. If there is only one 
section in a document, then the header and footer will appear on every page. However, if the 
document is separated into more than one section, different headers and footers can be created for 
each of the sections independently. 
 
2.1.1 Inserting a Header of Footer 
To insert a header or footer, do the following: 
 On the Insert tab/Header & Footer group, select either Header or Footer . 
 Select a Built-in Header or Footer style from the menu. 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
Alternatively, click Edit header or Edit Footer to see the Header or Footer section and begin 
inserting header/footer information. 
 

The Header or Footer boxes display the section number for the section you are currently working 
in.  

 

 

 

 Displays the number of the 
section in which the header or 
footer is inserted 

Choose a 
Built-in 

Header or 
Footer 

Click the 
Header or 

Footer button 

Click Edit Header or Edit 
Footer to display the 

Header or Footer section 

Section 2  Document Setup
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The header and footer boxes from section 2 onwards are automatically linked to each 
previous section’s header or footer. This can be useful, if either the header or footer needs 
to be consistent throughout the entire document. If not, you need to use the Link to 
Previous button to turn the link off. 

You can print specific sections of your document rather than just selected pages or the 
entire document. Select Print in the Microsoft Office Button menu and then select the 
Pages option. To print specific sections, precede the section number with the letter “s”. For 
example, s3,s5 would indicate to Word that you wish to print sections 3 and 5. If you entered 
p4s3-p6s5, this would indicate to Word that you wish to print from page 4 in section 3 to 
page 6 in section 5. 

You can use the Show Next and Show Previous buttons on the Header & Footer Tools ribbon 
to move between the different sections of your document.  

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Practice Sequence  

1 Ensure the Sections for Holidays in the Sun document is open.  

2 Imagine that you have decided that each new section starts on an odd page (that is a right-
hand page as you flick through a book or manual). At the moment, all of your section 
breaks are Next Page except for the last. 

 

3 Ensure you are working in Draft View so that you can easily view your section breaks.  

4 Click anywhere within section 2. Remember that if you wish to change the type of section 
break used, you need to be below the section break marker for the section you wish to 
change. 

 

5 Whilst in section 2 choose the Page Setup window launcher icon from the Page Layout 
tab. Click the Layout tab and set the Section start box to Odd Page. Ensure that the 
Apply to box is set to This section. Click OK to continue. 

 

6 If the section break at the end of section 1 does not automatically update to show the Odd 
Page indicator, go to Print Preview mode (from the Office Button) and then close to 
return to Draft View. 

 

7 Scroll down until you are anywhere in section 3. Using the same instructions as steps 5 and 
6 above, change the section break to an Odd Page break. 

 

8 Preview your document on completion to view its overall layout. Use the Print Layout View 
and return to page 1 of the document.  

 

9 Select the Insert tab and then, from the Header & Footer group, select Header. Select 
Edit Header. 

 

The Link to Previous button 
can be used to turn off the link 
between the current header or 
footer and the preceding one 

Displays Same as Previous if the 
header/footer is linked to the previous one 

note

note

Training for ECDL  Chapter 5  Preparing Outputs 

Unauthorised Photocopying is Unlawful     219 

10 Using the Go to Header and Go to Footer buttons, check that both the header and footer 
for section 1 are blank. Switch back to the Header-Section 1 box. 

 

11 Click the Show Next button to access the header for section 2. Notice that the Same as 
Previous option is displayed. This is because Word automatically links headers and 
footers from one section to another. Click the Link to Previous button on the Header & 
Footer Tools ribbon to break the link. In the Header box type the following header text: 
 
Holidays in the Sun 
 

 

12 Access the footer for section 2. Enter the following footer text using automatic page 
numbering for the number displayed. From the Header & Footer Tools/Design tab and the 
Header & Footer group, select the Page Number button. Select Current Position and 
Plain Number. 
 
The page number that has been inserted probably won’t be 1. This is because Word is 
counting the physical pages in the document and not in the section.  

 

In this part of the exercise, you are going to change the page number for section 2. 

13 Whilst still in the footer for section 2 click on the Page Number button in the Header & 
Footer Tools/Design tab. Select Format Page Number. Type 1 in the Start at box. Click 
OK. Don’t worry if the page number for section 2 now shows a 2. This will update to 1 when 
you close Headers & Footers.  

 

14 Switch back to the header for section 2. Click the Show Next button to move on to section 
3. This section will automatically use the Same as Previous setting and the preceding 
header text will automatically be displayed. In this case, however, you want the same 
heading to run through the headers for the entire manual so you don’t need to turn this 
setting off. 

 

15 Now switch down to the footer for section 3. This too has the Same as Previous setting but 
in this instance you don’t want to use it as each section will have its own unique section 
number and page numbering starting from 1. 

 

16 Click the Link to Previous button to turn off the link between the footer in section 2. 
Change the text Section 2 so that it reads Section 3. Now you need to change the page 
numbering back to start at one. If you need some help with this: 
 
Choose Page Numbers from the Headers & Footers group. Click the Format Page 
Numbers button and then type 1 in the Start at box. Click OK once. Then, Click Close to 
close the Page Number Format box.  

 

17 Switch between the header and footer so that you return to Header-Section 2. Click the 
Show Next button to view the header for section 4. Leave this set at Same as Previous. 

 

18 Switch down to the footer for section 4. Turn off the Link to Previous setting. Change the 
footer text to display Section 4. Update the automatic page numbering so that it starts 
again from 1. 

 

19 Close the header and footer area and return to the document.  

20 Using Print Preview, check the headers and footers throughout the entire document.   

21 Return to the document and then choose Print from the Microsoft Office Button menu. In 
the Pages box type s2 to print only the contents of section 2. Click OK to continue. 

 

22 Save the document, closing it on completion.  

 




